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IMPORTANT NOTICE 

All statements, technical information, and recommendations in this document which relate to the 

products supplied by Meggitt SA (Meggitt Sensing Systems) are based on information believed to be 

reliable, but unless otherwise expressly agreed in writing with Meggitt SA the accuracy or 

completeness of such data is not guaranteed. Before using this product, you must evaluate it and 

determine if it is suitable for your intended application. You should also check our website at 

www.meggittsensing.com/energy for any updates to data sheets, Ex certificates, product drawings, 

user manuals, service bulletins and/or other instructions affecting the product. 

Unless otherwise expressly agreed in writing with Meggitt SA, you assume all risks and liability 

associated with use of the product. Meggitt SA takes no responsibility for any statements related to the 

product which are not contained in a current English language Meggitt SA (Meggitt Sensing Systems) 

publication, nor for any statements contained in extracts, summaries, translations or any other 

documents not authored and produced by Meggitt SA. 

The certifications and warranties applicable to the products supplied by Meggitt SA are valid only for 

new products purchased directly from Meggitt SA or from an authorised distributor of Meggitt SA. 

Meggitt SA reserves the right to alter any part of this publication without prior notice. 

 

 

EXPORT CONTROL 
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PREFACE 

 

About these release notes 

This document provides important information about the VibroSight
®
 software from Meggitt Sensing 

Systems. It is applicable to all VibroSight-based condition monitoring systems using the versions of 

software described by this document, namely: 

 VibroSight software version 3.4.0 (CD part number 609-004-000-041). 

This document contains information about changes to the software since the previously released 

version (VibroSight 3.3.0), such as new features and improvements, solved problems and bug fixes, 

and hardware and software compatibility. 

For more general information on the actual software, or the entire condition monitoring system (CMS), 

refer to the following Meggitt Sensing Systems (MSS) documentation: 

 VibroSight software data sheet 

        (MSS document ref. 660-020-005-218A) 

 Getting started with VibroSight installation guide 

        (MSS document ref. 660-010-006-221A) 

 VibroSight help 

 VM600 XMV16 / XIO16T extended vibration monitoring card pair data sheet 

        (MSS document ref. 660-020-010-208A) 

 VibroSight application notes and technical notes. 

 

Users who are familiar with VibroSight may also find it useful to refer to the release notes included in 

earlier versions of the software: 

 VibroSight 2.9.0 (MSS document ref. VIBROSIGHT-RN/E) 

 VibroSight 2.9.1 (MSS document ref. VIBROSIGHT-RN/E) 

 VibroSight 2.9.2 (MSS document ref. VIBROSIGHT-RN/E) 

 VibroSight 2.9.4 (MSS document ref. VIBROSIGHT-RN/E) 

 VibroSight 2.9.5 (MSS document ref. VIBROSIGHT-RN/E) 

 VibroSight 2.9.6 (MSS document ref. VIBROSIGHT-RN/E) 

 VibroSight 2.9.7 (MSS document ref. VIBROSIGHT-RN/E) 

 VibroSight 2.10.0 (MSS document ref. VIBROSIGHT-RN/E) 

 VibroSight 2.10.1 (MSS document ref. 660-010-013-201A) 

 VibroSight 2.11.0 (MSS document ref. 660-010-013-203A) 

 VibroSight 2.11.1 (MSS document ref. 660-010-013-204A) 

 VibroSight 2.11.2 (MSS document ref. 660-010-013-205A) 
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 VibroSight 2.11.3 (MSS document ref. 660-010-013-206A) 

 VibroSight 2.11.4 (MSS document ref. 660-010-013-207A) 

 VibroSight 2.11.5 (MSS document ref. 660-010-013-208A) 

 VibroSight 2.11.6 (MSS document ref. 660-010-013-209A) 

 VibroSight 2.12.0 (MSS document ref. 660-010-013-210A) 

 VibroSight 2.12.1 (MSS document ref. 660-010-013-211A) 

 VibroSight 2.12.2 (MSS document ref. 660-010-013-212A) 

 VibroSight 2.12.3 (MSS document ref. 660-010-013-213A) 

 VibroSight 2.12.4 (MSS document ref. 660-010-013-214A) 

 VibroSight 2.12.5 (MSS document ref. 660-010-013-215A) 

 VibroSight 2.12.6 (MSS document ref. 660-010-013-216A) 

 VibroSight 2.12.7 (MSS document ref. 660-010-013-217A) 

 VibroSight 3.0.0 (MSS document ref. 660-010-013-218A) 

 VibroSight 3.1.0 (MSS document ref. 660-010-013-219A) 

 VibroSight 3.2.0 (MSS document ref. 660-010-013-220A) 

 VibroSight 3.3.0 (MSS document ref. 660-010-013-221A). 

 

 

Structure of the release notes 

This document presents information in the following order: general items first, then in terms of the 

software modules that constitute VibroSight, such as  Configurator,  Event Viewer,  Mimic, 

 Scope,  Server,  System Manager and  Vision. 

You should read those sections that are most relevant to you and then keep the document for future 

reference. 

 

Version identifiers 

A complete VibroSight software version number has four components that provide the following 

information: 

 Major release identifier: x.x.x.x 

 Minor release identifier: x.x.x.x 

 Update release identifier: x.x.x.x 

 Maintenance (build) release identifier: x.x.x.x 
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For each scheduled release of VibroSight, at least one of the first three digits changes (x.x.x.x). 

For unscheduled releases, that are occasionally required to solve urgent problems, only the fourth 

digit changes (x.x.x.x). 

The version identifiers for installed software appear in the Help About box (obtained using 

Help > About … in any VibroSight software module). 

 

Terminology 

To distinguish between the different Meggitt Sensing System products that can be used with the 

VibroSight
®
 software, the following terminology is used in this document: 

 VM600 card – to refer to the VibroSight-software compatible cards that are installed in a VM600 

rack. The currently available VM600 cards that are designed for operation with the VibroSight 

software are the XMx16 card pairs (XMC16 / XIO16T, XMV16 / XIO16T and 

XMVS16 / XIO16T) and the new CPUR/IOCR card pair. 

Where CPUx card is used in this document, it refers to CPUM and CPUR cards, and where 

IOCx card is used in this document, it refers to IOCN and IOCR cards, unless otherwise stated. 

Where XMx16 card is used in this document, it refers to XMC16 / XIO16T, XMV16 / XIO16T and 

XMVS16 / XIO16T cards, unless otherwise stated. 

 VibroSmart
®
 module or VibroSmart

®
 device – to refer to VibroSight-software compatible 

modules or devices that are used in a distributed monitoring system. The currently available 

VibroSmart modules and devices that are designed for operation with the VibroSight software 

are the VSI010, VSN010 and VSV30x. 

Where VibroSmart module is used in this document, it refers to the VSI010 and VSV30x 

modules, unless otherwise stated. 

Where VibroSmart device is used in this document, it can refer to the VSN010 device only, or to 

the VSI010 and VSV30x modules and the VSN010 device, unless otherwise stated. 
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1 Licensing 

In general, the licence required to enable purchased product options remains unchanged between 

update and/or maintenance level releases, for example, from version 3.3.0 to version 3.4.0. 

However, a new licence is always required for upgrades between major level releases, for example, 

from version 2.x.x to version 3.x.x. 

NOTE: VibroSight 3.4.0 is a minor level release and a new licence key file is not required 

for upgrades from VibroSight 3.3.0. 

However, a new licence key file is required for upgrades from VibroSight 2.x.x. 

 

To obtain a new VibroSight licence key file or for further information on licence keys, contact Meggitt 

Sensing Systems customer support. See 7 Customer support. 

 

 

2 Features 

General 

2.1 VibroSmart VSV30x support for hydro air-gap monitoring 

VibroSight 3.4.0 and the latest VibroSmart VSV30x firmware add support for air-gap monitoring and 

analysis with the VibroSight software’s ‘Hydro air-gap monitoring’ application specific package. 

(Previously, the “Hydro air-gap monitoring” application specific package could be used with VM600 

XMV16 and XMVS16 cards only.) 

The “Hydro air-gap monitoring” application specific package allows the air gap between rotor and stator, 

and the rotor and stator shapes (geometrical data) to be monitored for hydroelectric generators and other 

large motors and generators. 

NOTE: A new licence key file is required to enable optional packages, such as 

Hydro air-gap monitoring. 

 

Basically, air-gap measurement is used to quantify the radial distance between the poles of a rotating 

rotor inside a stator bore of a hydroelectric generator. The air gap is important since the distance is 

very small relative to the hydropower generator diameter (<0.5%) and a contact between the stator 

and rotor can be catastrophic. Additionally, the air gap in a hydropower generator tends to be smaller 

as the efficiency increases with a smaller air gap. The geometric parameters calculated from the air-

gap sensors allow monitoring the generator air gap and trending of change or evolution of these 

values overtime. 

In order to monitor the air gap around the circumference of the generator, several air-gap sensors 

(probes) are mounted at regular intervals on the stator, on a horizontal plane for a vertical axis 

machine. At least located 90° apartare required to give reasonable and representative values. 

However, for large diameters, this is not sufficient to represent all variations of the shape of the stator. 
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For example, 6 sensors are recommended for distances over 7 metres, 8 sensors for distances over 

10 metres and 12 sensors are recommended for distances over 13 meters.) 

Along the rotor axis, vertically for a vertical axis machine, as many as 3 layers (or planes) of sensors 

may be defined. Case histories of rotor rub show that the upper layer on the generator is the most 

sensitive. After the upper layer has been fully equipped, a lower layer can then be considered, as well 

as a layer in the middle, if justified by the generator height. 

In the future, the “Hydro air-gap monitoring” application specific package will be expanded to include 

other measurement such as rotor magnetic flux monitoring in order to provide a more comprehensive 

monitoring solution for larger machines. 

 

To use the Hydro air-gap monitoring package with VibroSmart VSV30x monitoring modules: 

 VibroSight Configurator is used to configure the VibroSmart VSV30x modules for the 

measurement chain being used, for example, the LS12x and ILS73x air-gap measuring 

systems from Meggitt Sensing Systems Vibro-Meter product line. 

 VibroSight Vision is used to display the resultant air-gap measurements using the existing 

VibroSight Vision plots. 

NOTE: At least four stator sensors are required to calculate stator and rotor shapes 

(geometrical data) and provide reasonable and representative values, therefore at 

least two VSV30x monitoring modules are required. 

 

 

To configure hydro air-gap monitoring for VibroSmart VSV30x monitoring modules using VibroSight 

Configurator: 

1. Start VibroSight Configurator, log in at the Admin user level and create a new VibroSight Server 

configuration (as usual). 

2. In the Hardware view, at the VibroSight Server Configuration node level, add a new VibroSmart 

measurement block and the new VSV30x modules (as usual). 

3. Under a VSV30x module, at the Input channels level, add and configure an Auxiliary input 

channel as a Tacho input channel in order to generate the 1/rev pulse required for Hydro air-

gap monitoring. 

NOTE: Although hydro air-gap monitoring can be used without a tacho (1/rev pulse) (for 

example, to get an overview of a hydroelectric generator), it is required in order to 

identify the individual rotor poles. 
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4. Under a VSV30x module, at the Input channels level, add and configure the Dynamic input 

channels to interface with the air-gap measurement chain being used. 

NOTE: The Dynamic input channels used for Hydro air-gap monitoring must be configured 

as follows: 

Physical Quantity: Airgap. 

Coupling: AC+DC. 

Sensitivity: As required (depends on the Signal Transmission Mode and the air-

gap measuring system being used). For example: 0.32 V/mm. 

Note: The LS120 and ILS730 air-gap measuring system has an offset of 1.875 mm 

and a sensitivity of 10 V / (33.125 mm − 1.875 mm) = 0.32 V/mm. 

 

Other parameters are configured depending on the requirements of the application. 

At least four stator sensors are required, therefore at least four Dynamic input 

channels must be configured. 

 

5. Under a VSV30x module, at the Processing blocks level, add and configure the Shaft relative 

vibration processing blocks used by a VSV30x to generate the waveforms that the Air-Gap 

Processing Block (VibroSight Server) requires. 

NOTE: The Shaft relative vibration processing blocks used by a VSV30x for Hydro air-gap 

monitoring must be configured as follows: 

Input channel: Select the associated Dynamic input channel (one per processing 

block). 

Reference speed: Select the associated Tacho input channel (one per 

measurement block). 

 

Other parameters are configured depending on the requirements of the application. 

At least four stator sensors are required, therefore at least four Shaft relative 

vibration processing blocks must be configured. However, all processing blocks 

used for hydro air-gap monitoring must use the same reference speed (tacho). 

 

6. Under each configured Shaft relative vibration processing blocks level, use the Gap extraction 

to configure the ‘offset’ depending on the air-gap measurement chain being used. 

NOTE: Under each Shaft relative vibration processing block, the Gap extraction must be 

configured as follows: 

Gap units: Physical value (engineering units). 

Initial gap: As required (depends on the Signal Transmission Mode and the air-

gap measuring system being used). For example: 1.875 mm. 

Alternatively, the initial gap can be entered as an electrical value (V or I) by using 

Gap units: Electrical value. 

Note: The LS120 and ILS730 air-gap measuring system has an offset of 1.875 mm 

and a sensitivity of 10 V / (33.125 mm − 1.875 mm) = 0.32 V/mm. 
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VibroSight implements the Hydro air-gap monitoring package at the VibroSight Server level, that is, it 

is post-processing performed by the VibroSight Server on the waveforms received from the Shaft 

relative vibration processing blocks used by a VSV30x. 

(When the Hydro air-gap monitoring package is used with VM600 XMV16 and XMVS16 cards, the 

post-processing is performed by the VibroSight Server on the principal mode waveforms received from 

the Dynamic processing blocks used by the XMV16 and XMVS16.) 

 

7. In the Hardware view, at the VibroSight Server node level, add a new Air-gap processing block 

to configure the hydro air-gap monitoring for the application. 

By default, three layers (Top, Middle and Bottom) are created, corresponding to planes 

perpendicular to the rotor axis, which allows for up to three layers of stator sensors to be 

defined for an Air-gap processing block. However, smaller machines typically require only one 

layer so unrequired layers can be deleted (for example, cases histories show that the upper 

layer on a generator is the most important for detecting rubs). 

8. At the server Air-gap processing block level, configure the basic parameters for the machine in 

order to allow the Air-gap processing block to understand the waveform signals and generate 

the hydro air-gap measurement data. 

NOTE: The Air-gap processing block must be configured as follows: 

Poles: The number of poles on the rotor of the machine. 

(Pole pairs is updated automatically depending on the poles.) 

Line frequency: The utility (mains power line) frequency of the machine. 

(Nominal speed is updated automatically depending on the poles and line 

frequency.) 

Maximum airgap: The maximum expected distance between the rotor and stator. 

Nominal airgap: The typical expected distance between the rotor and stator. 

Note: The Maximum and Nominal airgap values are used by VibroSight software to 

calculate the ‘threshold’ values used for pole detection. 

Numbering direction: The individual rotor poles are automatically numbered – 

after the 1/rev pulse – starting from 1 and increasing in the specified direction 

(viewing the machine from above and independently of the direction of rotation of 

the machine). 

Angle ref to notch (CW): By default, the 1/rev pulse produced by the timing 

reference mark on the rotor shaft and monitored by the associated Tacho input 

channel is located halfway between the first and the last poles. This parameter can 

be changed if a different pole numbering scheme is required. 
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9. Under the server Air-gap processing block level, for each Layer, configure each of the stator 

sensors (Probe 1 to Probe n). 

NOTE: Each Probe must be configured as follows: 

Input channel: Select the associated Dynamic input channel for the stator sensor. 

Input waveform: Select the associated waveform from the Shaft relative vibration 

processing block used by a VSV30x module that corresponds to the input channel. 

Sensor thickness: The combined thickness of the sensor and any glue used to 

install it on the surface of the stator (that is, the distance between the surface of the 

stator and the surface of the sensor facing the rotor). 

For example, an LS120 air-gap sensor has a thickness of 3.8 mm ±0.2  mm. 

Glue thickness depends on the particular adhesive used and the installation. 

 

10. Under the server Air-gap processing block level, for each Layer, configure the individual probe 

measurements available under each of the stator sensors (Probe 1 to Probe n): Rotor shape, 

Rotor signature, Gap Pn, Min gap, Avg gap, Rotor eccentricity, Rotor ellipticity, 

Rotor circularity. 

Full display range is available for all measurements but alarms can only be configured for 

“extracted” measurements (that is, alarms are not available for the Rotor shape or 

Rotor signature). 

11. Under the server Air-gap processing block level, for each Layer, configure the layer 

measurements available under each of the planes used (Top, Middle and Bottom): 

Layer rotor signature, Layer gap Pn, Layer min gap, Layer avg gap, Layer rotor eccentricity, 

Layer rotor ellipticity, Layer rotor circularity, Layer rotor shape, Layer stator eccentricity, 

Layer stator ellipticity, Layer stator circularity. 

Full display range is available for all measurements but alarms can only be configured for 

“extracted” measurements (that is, alarms are not available for the Layer rotor shape or 

Layer rotor signature). 

 

 

The VibroSight Hydro air-gap monitoring package requires that the air-gap measurements are added 

to a Shaft node in the Machinery view, so that the direction of rotation of the hydroelectric generator 

can be configured. (If the direction of rotation is not available, the air-gap measurements that require 

the direction of rotation in order to be calculated are flagged as bad quality and populated with zero 

values.) 

 

12. In the Machinery view, at the VibroSight server configuration node level, add a new Shaft 

(under a Machine unit and/or under a Facility unit, as required). 
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13. At the Shaft node level, configure the Global parameters for the hydroelectric generator’s 

shaft. 

NOTE: The Direction of rotation can be configured in one of two ways: 

Predefined: Allows the direction of rotation to be permanently configured as either 

Clockwise, Counter Clockwise or Clockwise and Counter Clockwise. 

Input Driven: Allows the direction of rotation to be configured as a function of an 

external system input. 

 

14. At the Shaft node level, add a new Air-gap measurements node. 

15. At the Air-gap easurements node level, use the Point control to select the Air-gap processing 

block configured in the Hardware view as the input. 

 

The configuration is now complete but must be saved as a ‘server / database’ before it can be used. 

For VibroSight Hydro air-gap monitoring, the VibroSight configuration is saved and activated as usual. 

Since VibroSight implements the Hydro air-gap monitoring package as post-processing at the 

VibroSight Server level, once the VibroSight Server is running, the air-gap processing (Server feature) 

must be enabled: 

For the VibroSight Server: 

 On the Status tab, under Device drivers, ensure that VibroSmart is enabled. 

 On the Status tab, under Server features, ensure that Air-gap is enabled. 

 

To display hydro air-gap monitoring measurements using VibroSight Vision: 

For VibroSight Hydro air-gap monitoring, VibroSight Vision is used to display the measurement data in 

the usual way: 

 Using the Machinery view or Hardware view to select the measurement or measurements to 

display. 

 Using the Time Range to select historical or live data (and the time period of interest for 

historical data). 

 

VibroSight Vision plot types are used to display hydro air-gap monitoring measurements. For example: 

 Bar Chart plots, Bode plots, Table plots and Trend plots can be used to display scalar “pole 

data” such as gaps and circularities, and vector “pole data” such as eccentricities and 

ellipticities. 

Typically, Bar Chart plots, Bode plots, Table plots and Trend plots display Airgap (amplitude) 

and additional pole information is automatically included in the plot legend. 

 Waveform plots can be used to display “waveform” and “rotor data” such as rotor shapes, rotor 

signatures, layer rotor signatures and layer stator shapes. For “rotor data”, a constructed 
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waveform is displayed where every pole is a constant amplitude value (the value measured for 

that pole). 

The Waveform plot’s x-axis can be configured as Time, Revolutions or Poles, as required, and 

additional gap information is automatically included in the plot legend. 

 Polar Waveform plots can be used to display “waveform” and “rotor data” such as rotor shapes, 

rotor signatures, layer rotor signatures and layer stator shapes. For “rotor data”, a constructed 

waveform is displayed where every pole is a constant amplitude value (the value measured for 

that pole). 

When displaying any gap related curve, the amplitude axis is automatically reversed so that the 

amplitude decreases radially going from the centre of the plot outwards. A gap related curve is 

plotted as a best-fit circle with a corresponding centre marker: “+” for rotor-related curves and 

“x” for stator-related curves. The centre marker and the curve will be the same colour. 

The Polar Waveform plot’s x-axis can be configured as Angle or Poles, as required, and 

additional gap, circularity, eccentricity and ellipticity automatically included is included in the plot 

legend. 

 

Application tips and tricks 

While the VibroSight software’s Hydro air-gap monitoring application specific package can be used 

with VM600 XMx16 cards and VibroSmart VSV30x modules, each solution has its advantages and 

disadvantages. 

For Hydro air-gap monitoring solutions using VibroSmart VSV30x modules: 

 One set of measurements (data) is provided per revolution of the machine (that is, effectively 

continuous data). 

For Hydro air-gap monitoring solutions using VM600 XMx16 cards: 

 One set of measurements (data) is provided every 100 milliseconds (that is, per principal 

measurement mode waveform). 

In general, VibroSmart VSV30x modules can be used to monitor slower machines with lower rotational 

speeds. 

 

See also 2.11 VSV30x modules: Support for hydro air-gap monitoring. 
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2.2 Interprocess communication – WCF replaces .Net Remoting 

The VibroSight software has been improved to completely replace the use of .Net Remoting with WCF 

(Windows Communication Foundation) for all interprocess communication required by the underlying 

client-server architecture of VibroSight. For example, this includes communication between a 

VibroSight Server and clients such as VibroSight Vision and VibroSight Mimic, and communication 

between VibroSight and other servers such as a VibroSight Modbus Server or a VibroSight OPC 

Server. 

WCF has been used to replace .Net Remoting in order to: 

 Improve performance, reliability and security. 

 Increase interoperability and extensibility. 

Now that VibroSight Mimic and VibroSight System Manager have also been migrated to WCF, the 

migration is complete (this work had started with and was mostly complete for VibroSight 3.3.0). 

Note: .Net Remoting had effectively become a “legacy” product that is supported by Microsoft for 

reasons of backward compatibility only. 

 

 

2.3 Latest GSD files for VM600 CPUx cards 

The VibroSight software has been updated to include the latest general station description (GSD) files 

for use with VM600 CPUx cards. 

NOTE: A general station description (GSD) file is a device description file provided with 

PROFIBUS and PROFINET devices. It is a text file that contains information about 

the basic capabilities and characteristics of a PROFIBUS or PROFINET device, 

and must be provided with the device. 

With a GSD file, system integrators can determine basic data such as the 

communications options and the available diagnostics, and the supervision 

software (PROFIBUS or PROFINET “master” device) can plan the configuration of 

the system. 

A GSE file is an English language specific version of a GSD file. 

 

The new CPUx GSD files are available from the default firmware (embedded software) folder after 

VibroSight is installed:  C:\Program Files\Meggitt\VibroSight\Firmware\VM600\CPUR 

NOTE: The default location for the Windows program files folder depends on the operating 

system installed on the computer: 

• C:\Program Files (x86)  is used by 64-bit versions of Windows. 

• C:\Program Files   is used by 32-bit versions of Windows. 

As a result, all references to the  Program Files  folder should be adapted by 

removing or adding  (x86)  as required. 
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The correct GSD file to use depends on the CPUx rack controller and communications interface card 

used by the VM600 rack to support PROFIBUS communications: 

 The  MGGCPUR2.GSD  file should be used for PROFIBUS communications with a CPUR card 

(PNR 600-026-xxx-xxx). This CPUR card (also known as the CPUR2) includes integrated support 

for PROFIBUS. 

 The  vm600m.gse  file should be used for PROFIBUS communications with a CPUM card 

(PNR 200-595-xxx-xxx). The CPUM card requires a Molex PROFIBUS interface card 

(PNR 600-018-000-001) to support PROFIBUS. 

 

Previously, the CPUx GSD file distributed with VibroSight was: 

 The  MGGT0FBE.GSD  file for PROFIBUS communications with earlier versions of the CPUR card 

(PNR 600-026-xxx-xxx). 

The latest  MGGCPUR2.GSD  file replaces this earlier  MGGT0FBE.GSD  file. 

 

 

2.4 Redundant Ethernet communications with VM600 XMx16 cards 

In order to improve the availability of a machinery monitoring system, the VibroSight software has 

been updated to support redundant Ethernet communication between a VM600 XMx16 / XIO16T card 

pair and a VibroSight Server. 

As before, when one Ethernet port of a VM600 XMx16 / XIO16T card pair is enabled, the VibroSight 

software automatically detects this and uses the Ethernet port for all communication with the card pair. 

But now, when both Ethernet ports of a VM600 XMx16 / XIO16T card pair are enabled and networked 

to the computer running the VibroSight Server, the VibroSight software automatically detects this and 

selects one of the Ethernet ports as the primary (active) and the other Ethernet port as the secondary 

(inactive/backup). 

NOTE: VibroSight selects the primary (active) and the secondary (inactive/backup) 

Ethernet ports based on the order in which the ports are detected and registered by 

the VibroSight software’s network device discovery mechanism. And the first port 

detected is the first one used (that is, the primary). 

 

During normal operation, the VibroSight software uses the primary (active) Ethernet port for all 

communication with the VM600 XMx16 / XIO16T card pair. However, if the card pair becomes 

unavailable via the primary (active) Ethernet port, then the VibroSight software detects this and 

automatically switches to the secondary (inactive) Ethernet port. That is, the primary (active) Ethernet 

port becomes inactive/backup and the secondary (inactive) Ethernet port becomes active. 

(Should the card pair subsequently become unavailable via the secondary Ethernet port, then the 

VibroSight software detects this and automatically switches to the primary and so on.) 
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NOTE: The time required by the VibroSight software to detect a problem and switch 

Ethernet ports depends factors such as the network configuration so it is difficult to 

be precise. However, it typically takes less than 30 seconds. 

 

(Previously, for applications such as condition monitoring, only one Ethernet port of a VM600 XMx16 / 

XIO16T card pair was typically used: either the XIO16T card’s Ethernet port (ETHERNET) at the rear 

of the VM600 rack or the XMx16 card’s Ethernet port (ETHERNET) at the front of the VM600 rack. 

And the unused Ethernet port of the VM600 XMx16/XIO16T card pair was disabled.) 

 

It is important to remember that when both Ethernet ports of an VM600 XMx16 / XIO16T card pair are 

enabled, a different subnet mask must be used for each Ethernet port in order to partition the networks 

used and ensure that the communications on each Ethernet port are kept separate from one another. 

NOTE: When both Ethernet ports of an XMx16/XIO16T card pair are required by an 

application, then a different subnet mask must be used for each Ethernet port in 

order to partition the networks used and ensure that the communications on each 

Ethernet port are kept separate from one another. 

 

VibroSight System Manager is used to configure (enable/disable) the Ethernet ports of a VM600 

XMx16 / XIO16T card pair, as follows: 

1. In the System Explorer window, select an XMx16 card (XMC16, XMV16 or XMVS16). 

An XMx16 card’s listing indicates the number of Ethernet ports that are enabled and networked for 

a card pair. For example: 

E123456 (xxx.xxx.xxx.xxx) indicates that one port is enabled. 

E123456 (xxx.xxx.xxx.xxx; xxx.xxx.xxx.xxx) indicates that both ports are enabled. 

2. In the Actions windows, click IP settings. 

3. In the IP settings window: 

 

If one Ethernet port of a VM600 XMx16 / XIO16T card pair is required by the application, use the 

XIO16T tab and the XMx16 tab to configure and enable one port, and disable the other port. 

NOTE: When only one Ethernet port of an XMx16 / XIO16T card pair is required by an 

application, the unused Ethernet port should be disabled. 

 

If both Ethernet ports of a VM600 XMx16 / XIO16T card pair are required by the application, use 

the XIO16T tab and the XMx16 tab to configure and enable both ports, ensuring that the 

IP address and Subnet mask are different for each port. 

NOTE: When both Ethernet ports of an XMx16/XIO16T card pair are required by an 

application, then a different subnet mask must be used for each Ethernet port in 

order to partition the networks used and ensure that the communications on each 

Ethernet port are kept separate from one another. 
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In the IP settings window, the error indication symbol (red circle containing a white x) is displayed 

against the IP address and Subnet mask fields to indicate any Ethernet port problems detected by 

VibroSight System Manager. Similarly, the Finish button becomes unavailable (greyed out) to prevent 

the Ethernet ports from being incorrectly configured. 

 

VibroSight Configurator is used to configure (connection mode) the Ethernet ports used by a VM600 

XMx16 card in a VibroSight Server Configuration, as follows: 

1. In the Hardware view window, select an XMx16 card (XMC16, XMV16 or XMVS16). 

The XMx16 card’s parameters (centre) indicate the Serial number, Connection mode, 

IP address 1 and IP address 2 for a card pair. 

o If the Connection mode is configured as Automatic discovery, then the VibroSight 

software’s network device discovery mechanism will automatically detect the Ethernet 

ports that are enabled and networked for a card pair (identified using the Serial number) 

and display them in IP address 1 and IP address 2. 

o If the Connection mode is configured as IP address, then the Ethernet ports that are 

enabled and networked for a card pair must be manually entered in IP address 1 and 

IP address 2. 

NOTE: When the Connection mode is configured as Automatic discovery, VibroSight 

displays the Ethernet ports in IP address 1 and IP address 2 based on the order 

in which the ports are detected and registered by the VibroSight software’s network 

device discovery mechanism. And the first port detected is the first one used (that 

is, IP address 1, the primary). 

 

2.5 Support for Direct measurement mode (direct data) removed 

Support for the Direct measurement mode (direct data) used by VM600 XMx16 cards has been 

removed as the VibroSight historical data repositories now used by VibroSight enable equivalent 

functionality. That is, VibroSight historical data repositories are so fast that the Principal measurement 

mode can be configured to provide continuous direct data (effectively a digitised continuous long-

duration waveform) of the type that was originally only available via the Direct measurement mode. 

Continuous direct data from the Principal measurement mode also has the important advantage that is 

native to VibroSight and can be quickly and directly displayed in VibroSight Vision, for example, using 

the Long Waveform plot. (Continuous direct data from the Direct measurement mode was not native to 

VibroSight and required third-party software in order to be displayed.) 

NOTE: In a VibroSight Server configuration, the different measurement modes for a 

VM600 XMx16 card are configured at the Spectra And Waveforms node level for 

a dynamic processing block using the corresponding Principal Mode and 

Auxiliary Mode tabs under Waveform and Spectrum Processing. 

(The Direct Mode tab previously available for the configuration of Direct 

measurement mode (direct data) has been removed.) 

By default, the principal measurement mode is enabled, while the auxiliary 

measurement mode is disabled. 
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(Previously, when VibroSight used databases based on Sybase
®
 SQL Anywhere, the Direct 

measurement mode (direct data) was used to obtain a digitised waveform for up to 10 minutes before 

an event (depending on an Alarm Event Based data logging rule). The special Direct measurement 

mode was required because of the speed and data handling limitations of the underlying database 

technology. The direct data waveforms obtained were encoded in the TDMS (technical data 

management streaming) file format from National Instruments, so the presentation of this direct data 

was not directly supported in VibroSight Vision: third-party software supporting the TDMS file format 

was required for data visualisation.) 

 

 

In order for the dynamic channel of a VM600 XMx16 card to provide continuous direct data (equivalent 

to the Direct measurement mode), VibroSight Configurator is used to configure the associated 

Dynamic processing block as follows: 

 At the Spectra and Waveforms node level, under Waveform and spectrum processing, on the 

Principal Mode (Principal measurement mode) tab, the Output State must be Enabled and the 

Overlap must be greater than 0%. 

NOTE: If there is no overlap in waveforms (Overlap less than or equal to 0%), then the 

data provided will not be continuous, that is, there will be gaps between the 

provided waveforms. 

The Overlap field is not editable; it displays the percentage waveform data overlap 

automatically calculated by VibroSight using values entered in the Bandwidth field 

(at the Dynamic processing block node level) and the Waveform size field (at the 

Spectra and Waveforms node level). 

 

 

 VibroSight Configurator 

2.6 Data logging rule changes 

In VibroSight Configurator, the data logging rules available for use in the Data Storage view have 

changed as follows: 

 The existing Value based data logging rule has been renamed as Single-value based. 

 A new Value based data logging rule has been added. 

 

The new Value based data logging rule has been added in order to support the logging (recording) of 

data to a VibroSight historical data folder (*.vshdf) by a VibroSight Server based on changes to 

individual data values with respect to their previously logged values. 

That is, when the new Value based data logging rule is used, values are only written to the VibroSight 

data repository when they are different from the previously written values. In this way, the size and 

growth rate of a VibroSight data repository can be significantly reduced. 
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For the new Value based data logging rule, the new specific parameters that can be configured are: 

 Delta % FDR – the % change to the associated data values (Data entities) in terms of their 

individual full display ranges (FDR) that is required to trigger the logging of new data values. 

 Delta frequency – the absolute change to the frequency of the associated data values 

(Data entities) that is required to trigger the logging of new data values. 

 Fastest logging rate – the fastest data rate that will be used to log (record) new data values to 

the VibroSight data repository, irrespective of the rate at which data value changes are detected. 

 Logging scope – the scope of the data logging rule, that is, the data values to log measurement 

data for when data value changes are detected. 

Select either the individual data entity that triggered this data logging rule, the data entities in the 

same processing block as the data entity that triggered this data logging rule (Processing block), 

or all of the associated data values in the Data entities folder of the data storage group containing 

this data logging rule (Logging group). 

 

Once configured, the following rules apply: 

 For scalar measurements (data entities), data values are logged when the difference between the 

previously logged scalar value and the current scalar value exceeds the configured Delta % FDR. 

 For vector measurements (data entities), data values are logged when the amplitude of the vector 

difference between the previously logged vector value and the current vector value exceeds the 

configured Delta % FDR. 

 For phasor measurements (data entities), data values are logged when at least one of the 

following conditions are met: 

o The difference between the previously logged frequency value and the current frequency 

value exceeds the configured Delta frequency. 

o The amplitude of the phasor vector resulting from the vector difference between the 

previously recorded phasor vector and the current phasor vector value exceeds the 

configured %FDR. Note that a phasor is the addition of a vector and a frequency value. 

 Other measurements (data entities) cannot trigger a Value based data logging rule. 

However, they can be added to a Value based data logging rule as associated data values 

(Data entities) so that they are logged if the Logging scope is configured as Processing block or 

Logging group. 

 

Concerning data logging, every time the new Value based data logging rule is triggered, both the 

previous data value (below the logging threshold) and the latest data value (above the logging 

threshold) are logged (recorded) to the VibroSight data repository. 
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Application tips and tricks 

In general, the VibroSight Configurator data logging rules should now be used as follows: 

 Time based – recommended for the logging of data at fixed time intervals. 

 Single-value based – recommended for the logging of data depending on the change in value of 

particular measurements with respect to their previously logged (recorded) values. 

 Value based – recommended for the logging of data depending on the value or change in value of 

a particular measurement. 

 Alarm-event based – recommended for the logging of data depending on the severity level or 

levels associated with a particular measurement. 

 

 

 VibroSight Vision 

2.7 Displaying data against speed in a Trend plot 

The Trend plot and the optimised data handling implemented by the VibroSight software have been 

updated to support the plotting of measurement data against speed. 

More specifically, when a Trend plot is configured as Speed/Bode (as opposed to Time/APHT) so 

that the measurement data (Y-axis) is displayed against speed (X-axis), VibroSight’s optimised data 

handling algorithm now reduces (decimates) and optimises the data selected for display more 

intelligently in order to provide a ‘picture’ of measurement data against speed that is more correct and 

easier to work with. 

(Previously, the VibroSight’s optimised data handling algorithm was correct and easier to work with 

when measurement data against time.) 

 

 

2.8 Displaying phase data in a Spectrum plot 

The Spectrum plot has been updated to support the plotting of phase data. 

By default, when a Spectrum plot is displayed, the amplitude spectrum is displayed and the phase 

spectrum is not displayed. 

(Previously, the Spectrum plot supported the display of amplitude data only, equivalent to the default 

behaviour.) 

 

To configure the plotting of phase data in an individual Spectrum plot, the properties of the plot can be 

changed as follows: 

1. Right-click the plot, then click Plot properties, or click the Plot > Plot properties menu command. 

    The Plot properties window for the Spectrum plot is displayed. 
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2. In the Plot properties window, on the General tab, under Layout, notice that the Amplitude 

control is selected by default to enable the display of amplitude data. Select (or clear) the Phase 

control as required to display (or not display) amplitude data, then click Apply or OK. 

The updated settings configured for the individual Spectrum plot are immediately applied to the plot. 

NOTE: Any combination of amplitude data and/or phase data can be displayed in a 

Spectrum plot. 

By default, the amplitude spectrum is displayed as a single chart in the plot. 

When both the amplitude and phase data are selected, the amplitude spectrum 

and the phase spectrum are displayed as two separate charts in the plot with the 

amplitude spectrum above the phase spectrum. 

Similarly, the phase spectrum can be displayed as a single chart in the plot. 

 

Alternatively, the default plot settings for all Spectrum plots can be changed as follows: 

1. Click the Tools > Options menu command. 

    The Options window for VibroSight Vision is displayed. 

2. In the Options window, select Spectrum plot (left pane), and under General (right pane), select or 

clear the Amplitude and/or Phase controls as required, then click OK. 

The updated default settings configured for all Spectrum plots are used the next time that a Spectrum 

plot is created. 

 

 

2.9 Display of units and qualifiers in plots 

VibroSight Vision plots have been updated to use the default units and qualifiers configured for a 

measurement (data entity). 

The units and qualifiers now used and displayed in a VibroSight Vision plot are those configured for 

the data entity in VibroSight Configurator, in accordance with the following rules: 

 For plots arranged to display one Y-axis per measurement (single curve), the Y-axis displays the 

unit and/or qualifier configured for the measurement in VibroSight Configurator. If no unit and/or 

qualifier is configured for the measurement in VibroSight Configurator, then the default values 

from the VibroSight Unit Preferences are used. 

 For plots arranged to display one Y-axis for measurements with the same physical quantity 

(multiple curves) and the units and/or qualifiers configured in VibroSight Configurator are the 

same, the Y-axis displays the common unit and/or qualifier configured for the measurements in 

VibroSight Configurator. 

For plots arranged to display one Y-axis for measurements with the same physical quantity 

(multiple curves) and the units and/or qualifiers configured in VibroSight Configurator are different, 

multiple Y-axes are used to group and display the common units and/or qualifiers configured for 

the measurements in VibroSight Configurator. 
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2.10 Improved zooming in plots 

The zoom functionality in VibroSight Vision plots has been further improved to support zooming using 

the mouse wheel, as follows: 

 Rotating the mouse wheel forwards will zoom in on the plot, centered around the position of the 

pointer. This is the mouse wheel equivalent of Frame zoom using the pointer. 

Similarly, CTRL + rotating the mouse wheel forwards will zoom in vertically on the plot (that is, the 

X-axis remains as it was and the Y-axis zooms). This is the mouse wheel equivalent of 

Vertical zoom using the pointer. 

Similarly, SHIFT + rotating the mouse wheel forwards will zoom in horizontally on the plot (that is, 

the X-axis zooms and the Y-axis remains as it was). This is the mouse wheel equivalent of 

Horizontal zoom using the pointer. 

 Rotating the mouse wheel backwards will zoom out on the plot, centered around the position of 

the pointer. 

Similarly, CTRL + rotating the mouse wheel backwards will zoom out vertically on the plot (that is, 

the X-axis remains as it was and the Y-axis zooms). 

Similarly, SHIFT + rotating the mouse wheel backwards will zoom out horizontally on the plot (that 

is, the X-axis zooms and the Y-axis remains as it was). 

NOTE: When zoomed on a plot, clicking on the small icon that appears at the left of the 

X-axis and/or the bottom of the Y-axis left resets the zoom for that axis. 

 

Note: This new zoom functionality is available in all VibroSight Vision plots except for the Polar plot 

and the Polar Waveform plots, which are currently planned to support zooming using the mouse wheel 

for the next release of VibroSight. 

 

 

VibroSmart modules 

2.11 VSV30x modules: Support for hydro air-gap monitoring 

The VibroSmart VSV30x firmware now includes support for hydro-air-gap monitoring. 

The ways in which a VibroSmart VSV30x module provides data to a VibroSight Server have been 

improved to provide the continuous direct data (effectively a digitised continuous long-duration 

waveform) supported by the VibroSight software’s ‘Hydro air-gap monitoring’ application specific 

package. 

NOTE: In order to run VibroSight 3.4.0 for machinery monitoring systems containing 

VibroSmart VSV30x modules, a firmware upgrade to the latest version of VSV30x 

firmware is required. See 5.3 VibroSmart devices. 

 

See also 2.1 VibroSmart VSV30x support for hydro air-gap monitoring.  
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3 Solved problems and bug fixes 

General 

3.1 Improvements and bug fixes 

General stability improvements across the VibroSight 3.4.0 software. 

 

3.2 VM600 XMx16 card auxiliary measurement mode processing 

Under certain circumstances, VM600 XMx16 cards configured to use the auxiliary measurement mode 

processing to provide waveforms could experience communication errors with a VibroSight Server. 

 

3.3 VM600 XMC16 card combustion monitoring processing 

Under certain circumstances, VM600 XMC16 cards configured to use 1 s spectral data aggregation 

processing and the combustion monitoring processing block to provide aggregated spectra and 

associated measurements (extracted data) could provide incorrect values. 
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4 Known issues 

4.1 Display of timestamps in VibroSight Vision 

In VibroSight Vision, when the timestamps (date and time) are configured to be displayed as Site time 

or Local computer time and the site time or local computer time is subsequently changed on the 

relevant computer (for example, using Windows > Control Panel > Date and Time), this change is not 

reflected in the VibroSight Vision user interface until the user clicks on the Timestamp displayed in 

the VibroSight Vision status bar. 

 

4.2 VibroSight Server and Host Service restart required after changes to 
network adapter 

If the configuration of a network adapter is changed (for example, enabled or disabled, connected or 

disconnected) on a computer running VibroSight, then the VibroSight Servers and Host Services 

running on the computer must be restarted in order for the network adapter to be recognized by the 

VibroSight discovery mechanism. 

 

4.3 Length limitation of VibroSight Server instance names 

Since VibroSight 2.9.6, VibroSight Server instance names are limited to 18 characters, whereas up to 

27 characters were allowed in previous versions. This constraint is enforced during the creation of new 

server instances with VibroSight 2.9.6 or later. 

NOTE: VibroSight allows only alphanumeric characters (A to Z, a to z, 0 to 9), the 

hyphen-minus character ( - ) and the underscore character ( _ ) to be used for 

VibroSight Server names. 

 

However, existing server instances may be non-compliant (too long) and no longer run after an 

upgrade of the VibroSight software. In such cases, the file names used for the VibroSight Server 

database file (*.vssrvdb or *.db) and the VibroSight Server configuration file (*.vssrvcfg or 

*.config) should be updated (and manually edited in the VibroSight configuration file) to be 

18 characters or less. Changes may also be required in any VibroSight software that references the 

server instance name, such as VibroSight Vision projects. 

Where used, the automated database copies append a timestamp (_yyyyMMddHHmmss) to the 

Server instance name which reduces the number of file name characters that remain available for 

VibroSight Server instance names to three. Alternatively, the server instance name can be shorted 

after the database copy is complete. 

Also, depending on the VibroSight Server database file names used and any truncation performed by 

VibroSight, it is possible that servers are created with names that contain non-allowed characters 

(such as spaces), with the result that these servers will not be accessible by VibroSight software 

clients. Similarly, duplicate VibroSight Server names are also possible. 
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NOTE: Choose appropriate VibroSight Server names in order to avoid name conflicts 

arising due to truncation and/or additional databases being created during 

automatic data management. 

This is particularly important for systems with automated data management and 

system backup procedures that use script files containing database commands 

(such as copy and backup) that can automatically generate VibroSight Server 

database files. 

 

4.4 Display of timestamps in VibroSight clients other than VibroSight Vision 

Although VibroSight Vision now supports the display of timestamps (date and time) as either Site time, 

UTC time or Local computer time, all other VibroSight client software modules continue to display 

timestamps in local computer time only (that is, the date and time according to the local clock of the 

computer running the VibroSight software module). 

 

4.5 Display of devices in VibroSight System Manager 

In the System Explorer window of VibroSight System Manager, the Devices tree-view does not always 

update correctly to show all of the devices (VM600 cards and VibroSmart devices) available on the 

network. 

In particular, this has been seen when changing the firmware of a device, and can persist even after a 

refresh (using the Refresh toolbar button or View > Refresh). 

If this behaviour is seen, the recommended workaround is to: 

 Wait a few minutes and refresh again. 

 Restart VibroSight System Manager. 

 

4.6 VibroSight Mimic backwards compatibility 

VibroSight 2.10.0 contained significant improvements and changes, including a separate VibroSight 

Mimic client software module for mimics (that were previously available in VibroSight Vision). As a 

result, VibroSight Vision mimics created with VibroSight 2.9.7 or earlier are not compatible with 

VibroSight 2.10.0 or later. 

VibroSight 2.11.0 contained significant improvements and changes to the VibroSight Mimic client 

software module. As a result, VibroSight Vision mimics created with VibroSight 2.10.1 or earlier are 

not compatible with VibroSight 2.11.0 or later. 

VibroSight 2.11.5 contained significant improvements to the VibroSight Mimic project framework to 

include version information, in order to improve the compatibility between projects created with 

different versions of VibroSight Mimic and eliminate the requirement for the recreation of Mimics. 

Starting with VibroSight 2.11.5, Mimic projects automatically detect any changes in the VibroSight 

Mimic software that affect project compatibility, inform the user and update the project as required. 
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NOTE: VibroSight 2.11.5 is also able to open and work with Mimic projects created with 

VibroSight 2.11.0 or later, if the corresponding database had been updated as 

required. 

 

NOTE: When updating existing machinery monitoring projects created with 

VibroSight 2.12.x to VibroSight 3.x.x, a new data repository created by copying a 

VibroSight database (*.vssrvdb) to a VibroSight historical data folder (*.vshdf) 

must use the same server file name as the existing server in order for existing 

VibroSight Mimics to maintain links with the data repository and continue to work 

(without manual corrections). 

In addition, the VibroSight Server using the new data repository must be running 

before the existing VibroSight Mimics are run for the first time, after the update. 

 

4.7 VibroSight OPC Clients not recovering 

When a VibroSight OPC Client is being used to import information from an external OPC server into a 

VibroSight system and the external OPC server becomes unavailable, the VibroSight OPC Client may 

not always recover automatically when the OPC server becomes available again. 

This is typically characterised by the VibroSight OPC Client continuing to show connection error 

messages even when OPC server is available and can result in permanent loss of the imported data if 

not noticed. 

NOTE: The external OPC data can be permanently lost if it is not imported into VibroSight 

as expected. 

Any VibroSight system feature or configuration element relying on the imported 

OPC data will not behave as expected, for example, alarms, machinery operating 

conditions and data logging rules. 

 

If this behaviour is seen, the recommended workaround is to: 

 Stop and restart the VibroSight OPC Client from either the VibroSight Server 

(Data > Acquisition > OPC Device Driver) or VibroSight System Manager. 

 Stop and restart the VibroSight Server, if required. 

 

4.8 Duplicate events 

For VibroSight systems using VM600 XMx16 cards, VibroSight Event Viewer retrieves all of the event 

information available from the data buffers on the cards. 

For VibroSight systems using VibroSmart modules, VibroSight Event Viewer retrieves the event 

information available from the current time only (no buffered events). 

Accordingly, for a VibroSight system using VM600 XMx16 cards, there is the possibility of duplicate 

events being listed in the Event Viewer, particularly for VibroSight systems being operated without an 

NTP server (where events are not recognised as duplicates due to time drift). 
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4.9 VibroSight Server status indicators 

The status indicators (performance counter monitors) on the Status tab of the new VibroSight Server 

are not correctly displayed and updated when an NVIDIA WMI driver is installed on the same 

computer as the VibroSight Server. 

NOTE: The NVIDIA Enterprise Management Toolkit (NVWMI) is a graphics and display 

management and control technology that interfaces to Microsoft’s Windows 

Management Instrumentation (WMI) infrastructure, specific to NVIDIA graphics 

processing units (GPUs). 

 

This is because NVIDIA WMI prevents the Microsoft .NET Framework from obtaining the required 

counter values from the underlying operating system / computer. 

 

4.10 XMx16 card pre-logging 

For an XMx16 card pair, if Dynamic Input Channel 16 is used as an input to a Dynamic Processing 

Block that is used as an input to a Dual Shaft Relative Processing Block which is configured to provide 

an Orbit and/or Full Spectrum output, then any pre-logging configured for the principal mode 

Waveform and/or Spectrum of Dynamic Input Channel 16 will not actually log any of the data from the 

same pre-logging scope. 

 

4.11 Problems creating new VibroSight OPC Servers 

Users who have upgraded from an earlier version of VibroSight to a later version (for example, from 

VibroSight 2.x.x or 3.0.0 to VibroSight 3.1.0) can experience problems when creating new VibroSight 

OPC Servers. 

Such problems are typically characterised by the OPC Server Create command in VibroSight System 

Manager displaying an error message such as 

“The type initializer for ‘ch.VibroMeter.Xms.OpcServer.Utils.OpcServerUtils’ 

threw an exception”. 

This typically occurs because an earlier version of the OpcServer.config file required by VibroSight 

OPC Servers is being used by the later installation of VibroSight, which can happen in one of two 

ways: 

 When a later version of VibroSight 3.x.x is installed on a computer that was running an earlier 

version of VibroSight 2.x.x, the VibroSight installer automatically checks existing VibroSight folders 

(such as C:\ProgramData\Meggitt\VibroSight 2) in order to copy relevant system and/or user 

preference files across to the new VibroSight folders (such as 

C:\ProgramData\Meggitt\VibroSight), including an earlier OpcServer.config file. 

 When VibroSight 3.1.0 is installed on a computer that was running VibroSight 3.0.0, the creation of 

a VibroSight OPC installer using VibroSight 3.0.0 automatically created an earlier 

OpcServer.config file. 
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As shown below, the first few lines of a typical OpcServer.config file contains version specific 

information that is incompatible with later versions of VibroSight: 

<?xml version="1.0" encoding="utf-8"?> 

<configuration> 

  <configSections> 

    <section name="opcServersConfiguration" 

type="ch.VibroMeter.Xms.OpcServer.Utils.OpcServersSystemConfiguration, 

XmsOpcServerUtils, Version=2.0.0.0, Culture=neutral, 

PublicKeyToken=2db2a2387bac0a0a" /> 

  </configSections> 

… 

</configuration> 

 

So for users who have upgraded from an earlier version of VibroSight to a later version, if problems 

are experienced when creating new VibroSight OPC Servers, the workaround is to: 

 

1. Use an XML-compatible text editor program to edit the OpcServer.config file and remove the 

version specific information. That is, change the line containing the section name 

from: 

<section name="opcServersConfiguration" 

type="ch.VibroMeter.Xms.OpcServer.Utils.OpcServersSystemConfiguration, 

XmsOpcServerUtils, Version=2.0.0.0, Culture=neutral, 

PublicKeyToken=2db2a2387bac0a0a" /> 

to: 

<section name="opcServersConfiguration" 

type="ch.VibroMeter.Xms.OpcServer.Utils.OpcServersSystemConfiguration, 

XmsOpcServerUtils, Culture=neutral, PublicKeyToken=2db2a2387bac0a0a" /> 

 

2. Restart the computer. 

    Note: The computer must be restarted to ensure that the edited version of the OpcServer.config 

    file is used (and not some other version from cache memory). 

 

3. Use the OPC Server Create command in VibroSight System as required. 

 

NOTE: The manual migration of existing VibroSight OPC Servers to VibroSight 3.x.x is 

described in detail in the “VibroSight OPC Server migration” section of the latest 

 Getting started with VibroSight installation guide. 
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4.12 Potential TCP port 50000 conflict 

The VibroSight Host Service (XmsHostService.exe) requires TCP port 50000 for communication with 

the VibroSight software. So if the computer running the VibroSight software is running other software 

which also requires TCP port 50000, this results in a TCP port conflict which can prevent VibroSight 

(or the other software) from running. 

During the VibroSight software installation process, the VibroSight 3.4.x installer will typically detect 

other software on the computer that is using TCP port 50000 and report this. For example: “The port 

50000 cannot be used. Please close all application using this port before manually starting the host 

service.” 

Accordingly, any potential TCP port 5000 conflict should be resolved before the VibroSight software 

can be successfully installed and run. 

 

 

 

  



     

   
 

 

     

 

     
 32 / 56 Release Notes VIBROSIGHT-RN/E (660-010-013-222A) 

Release 3.4.0 – January 2018 
 

     
 

5 Compatibility 

As part of the VibroSight software installation process, the VibroSight installer will automatically check 

to see if the required Microsoft .NET Framework, Microsoft Visual C++ Redistributable Package and 

OPC Core Components Redistributable software are pre-installed on the computer: 

 The required Microsoft Visual C++ Redistributable Package (see section 5.1.3) must be manually 

installed before VibroSight can be installed. If it is not detected, then the VibroSight installer will 

exit the installation and VibroSight is not installed. 

 The required Microsoft .NET Framework (see section 5.1.2) is automatically installed by the 

VibroSight installer if it is not detected. 

 The required OPC Core Components Redistributable (see section 5.1.4) software is automatically 

installed on the computer by the VibroSight installer if it is not detected. 

NOTE: Refer to the latest version of the  Getting started with VibroSight installation 

guide or the  VibroSight software data sheet for further information on 

VibroSight’s prerequisites and compatibility. 

 

5.1 VibroSight software 

VibroSight 3.4.0 is a minor level release and replaces VibroSight 3.3.0. 

Compatibility with existing VibroSight data repositories (databases) is achieved using a specific data 

migration process from any existing databases based on Sybase SQL Anywhere (*.vssrvdb) to data 

repositories based on the VibroSight historical data repositories (VibroSight historical data folders 

(*.vshdf) for operation with a VibroSight Server (live data) and VibroSight historical data archives 

(*.vshda) for operation with historical data). 

Compatibility with existing VibroSight machinery monitoring projects using VibroSight OPC Servers 

that were created using VibroSight 2.12.7 or earlier is achieved using a specific VibroSight OPC 

Server migration process for these VibroSight OPC Servers. 

Therefore, it is important to note that: 

 New machinery monitoring projects created with VibroSight 3.x.x will automatically use VibroSight 

historical data repositories. 

 Existing machinery monitoring projects created with versions of VibroSight earlier than 

VibroSight 3.0.0 must be manually migrated from Sybase SQL Anywhere databases to VibroSight 

historical data repositories before they can be used with VibroSight 3.x.x. 

 Existing machinery monitoring projects using VibroSight OPC Servers that were created with 

versions of VibroSight earlier than VibroSight  2.12.7 must manually migrate their VibroSight OPC 

Servers before they can be used with VibroSight 3.x.x. 

It is very important to note that migrating a VibroSight OPC Server from VibroSight 2.12.7 or 

earlier to VibroSight 3.x.x requires that certain steps must be performed using the existing version 

of VibroSight (that is, VibroSight 2.12.7 or earlier) BEFORE it is removed (uninstalled). 



     

 
 

   

     

 

     
 Release Notes VIBROSIGHT-RN/E (660-010-013-222A) 

Release 3.4.0 – January 2018 33 / 56  

     
 

NOTE: The manual migration of an existing machinery monitoring project to 

VibroSight 3.x.x is described in detail in the “Data migration” and “VibroSight OPC 

Server migration” sections of the latest  Getting started with VibroSight 

installation guide. 

 

5.1.1 Microsoft Windows operating systems 

VibroSight 3.x.x is compatible with 32-bit versions and 64-bit versions of Microsoft 
®
 Windows 

®
 

operating systems. 

NOTE: Starting with VibroSight 3.0.0, VibroSight software is now available as 64-bit 

software for 64-bit Windows and 32-bit software for 32-bit Windows. 

The 64-bit version of VibroSight can be installed on 64-bit Windows computers 

only. The 32-bit version of VibroSight can be installed on 32-bit Windows 

computers only. Only a single version of VibroSight can be installed and exist on a 

computer at any one time 

 

See the Appendix of these release notes for further information on VibroSight software and Windows 

operating system compatibility. 

 

5.1.2 Microsoft .NET Framework 

For most Windows operating systems, VibroSight 3.4.0 or later requires that the Microsoft .NET 

Framework 4.7.1 or later is installed. 

NOTE: VibroSight 3.4.0 requires Microsoft .NET Framework 4.7.1. 

 

If the required Microsoft .NET Framework is not pre-installed, then the VibroSight installer will detect 

this and automatically install it as part of the VibroSight software installation. 

See the Appendix of these release notes for further information on VibroSight software and Microsoft 

.NET Framework requirements. 

 

5.1.3 Microsoft Visual C++ Redistributable Package 

VibroSight 3.x.x requires that the Microsoft Visual C++ Redistributable Package for Visual Studio 2015 

is installed, in order to install and register the Visual C++ libraries used by VibroSight. 

NOTE: The 64-bit version of the Microsoft Visual C++ Redistributable Package (“Microsoft 

Visual C++ 2015 Redistributable (x64)”) must be installed on 64-bit Windows 

computers. 

The 32-bit version of the Microsoft Visual C++ Redistributable Package (“Microsoft 

Visual C++ 2015 Redistributable (x86)”) must be installed on 32-bit Windows 

computers. 

 

If the required Microsoft Visual C++ Redistributable Package is not pre-installed, then the VibroSight 

installer will detect this and exit the installation. 
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5.1.4 OPC Core Components Redistributable 

VibroSight 3.x.x requires that the OPC Core Components Redistributable is installed, in order to 

configure and run VibroSight OPC Clients and VibroSight OPC Servers correctly: the redistributable 

must be installed on OPC client computers in order to allow connections to remote OPC servers and it 

must be installed on OPC server computers in order to allow OPC clients to browse for running OPC 

servers. 

NOTE: The 64-bit version of the OPC Core Components Redistributable (“OPC Core 

Components Redistributable (x64) 106.0”) must be installed on 64-bit Windows 

computers. 

The 32-bit version of the OPC Core Components Redistributable (“OPC Core 

Components Redistributable (x86) 106.0”) must be installed on 32-bit Windows 

computers. 

 

If the required OPC Core Components Redistributable is not pre-installed, then the VibroSight installer 

will detect this and automatically install it as part of the VibroSight software installation. 

 

5.1.5 Sybase SQL Anywhere 11 software 

Starting with VibroSight 3.0.0, the VibroSight historical data repositories (VibroSight historical data 

folders (*.vshdf) for operation with a VibroSight Server (live data) and VibroSight historical data 

archives (*.vshda) for operation with historical data) are exclusively used for the required data 

repositories. 

A VibroSight database based on Sybase SQL Anywhere (*.vssrvdb) can no longer be used as a 

data repository. Accordingly, the Sybase SQL Anywhere 11 database software is no longer included 

and distributed as part of the VibroSight software. 

NOTE: VibroSight 3.x.x exclusively uses data repositories based on the VibroSight 

historical data system. 

VibroSight 2.12.7 used data repositories based on Sybase SQL Anywhere 

databases and introduced initial support for working with data repositories based 

on the VibroSight historical data repositories for data analysis. 

VibroSight 2.12.6 or earlier exclusively used data repositories based on Sybase 

SQL Anywhere databases. 

 

NOTE: The manual migration of an existing machinery monitoring project to 

VibroSight 3.x.x is described in detail in the “Data migration” section of the latest 

 Getting started with VibroSight installation guide. 
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5.1.6 VM600 CMS software 

The VM600 CMS software from Meggitt Sensing Systems uses Sybase SQL Anywhere 8. Both 

Sybase SQL Anywhere 8 (VM600 CMS) and Sybase SQL Anywhere 11 (VibroSight) can be installed 

on the same computer. 

However, while SQL Anywhere 8 and SQL Anywhere 11 can be installed on the same computer and 

run at the same time for standard database operations, certain administrative tasks are mutually 

exclusive and may block one another. 

More specifically, all operations that refer to Sybase SQL (a command-line Interactive SQL utility) in 

the background could be directed to the wrong version of Sybase SQL Anywhere. For example, this 

impacts all user operations and system operations involving the creation, copying and updating of 

databases. 

NOTE: It is recommended to install and use VibroSight 3.x.x or earlier on a computer that 

does not have VM600 CMS software installed. 

 

5.1.7 SIMATIC Step 7 software 

The SIMATIC Step 7 software from Siemens typically uses Sybase SQL Anywhere 9. Both Sybase 

SQL Anywhere 9 (SIMATIC Step 7) and Sybase SQL Anywhere 11 (VibroSight) can be installed on 

the same computer. 

However, while SQL Anywhere 9 and SQL Anywhere 11 can be installed on the same computer, they 

cannot run at the same time. 

More specifically, if SIMATIC Step 7 and VibroSight are both installed, certain administrative tasks, 

such as all user operations and system operations involving the creation, copying and updating of 

databases, may not work correctly. If this behaviour is seen, the recommended workaround is to 

manually change or remove the SQLANY environmental variable in order to allow VibroSight to work 

correctly. 

Note: The SQLANY environment variable is used to contain the directory where Sybase SQL 

Anywhere is installed. 

NOTE: It is recommended to install and use VibroSight 3.x.x or earlier on a computer that 

does not have SIMATIC Step 7 software installed. 

 

5.1.8 Dell Backup and Recovery software 

Some Dell™ computers running versions of Dell Backup and Recovery software can experience 

problems running the VibroSight software, characterised by the VibroSight software not running or 

running incorrectly. This is because the Dell Backup and Recovery software can use a version of 

SQLite and associated libraries (DLLs) that prevent the VibroSight Host Service from running 

correctly. 

For example, VibroSight clients can stop running (crash), VibroSight clients can be unable to connect 

to data sources and/or VibroSight System manager may not display all of the commands expected to 

be available in the Actions window. 
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If this behaviour is seen, the recommended workaround is to uninstall the Dell Backup and Recovery 

software. 

NOTE: It is recommended to install and use VibroSight 3.x.x or earlier on a computer that 

does not have Dell Backup and Recovery software installed. 

 

5.1.9 MatrikonOPC software 

Both MatrikonOPC™ software and the VibroSight software can be installed and run on the same 

computer. 

However, if the MatrikonOPC software is installed after the VibroSight software, this can result in 

problems related to credentials (access rights). These problems are typically characterised by an 

unhandled exception in VibroSight Configurator when trying to configure an OPC device in the 

Hardware view or an unhandled exception in a VibroSight Server when trying to handle/process OPC 

data. 

MatrikonOPC software and the VibroSight software must be installed on the same computer in the 

following order: 

1. Install the MatrikonOPC software. 

2. Install the Microsoft Visual C++ Redistributable Package for Visual Studio 2010 (version 40219). 

Note: This redistributable package is required by the MatrikonOPC software. 

3. Install the Microsoft Visual C++ Redistributable Package for Visual Studio 2015 (version 23026 

or later). Note: This redistributable package is required by the VibroSight software. 

4. Install VibroSight 3.x.x. 
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5.2 VM600 cards 

5.2.1 Firmware 

There are firmware updates for some VM600 cards corresponding to VibroSight 3.4.0. 

The latest firmware for the CPUR is now: 

 Base System: base-system-640-014-001-002.tgz 

 Applications:  applications-640-015-001-002.tgz. 

The latest firmware for the XMC16, XMV16 and XMVS16 remains: 

 Base System: base-system-640-003-001-016.tgz 

 Applications:  applications-640-010-001-016.tgz. 

Therefore, for current versions of VM600 CPUR cards, firmware upgrades are strongly recommended. 

Improvements to this latest VM600 CPUR firmware includes a fix for a known time counter 

wraparound (overflow) issue. Refer to the ‘VM600 CPUx time counter wraparound (overflow)’ service 

bulletin (CPUx-001) for further information. 

NOTE: In order to run VibroSight 3.4.0 for machinery monitoring systems containing 

VM600 CPUR cards, a firmware upgrade to the latest version of CPUR firmware is 

strongly recommended. 

 

5.3 VibroSmart devices 

5.3.1 Firmware 

There are firmware updates for some VibroSmart modules and devices corresponding to 

VibroSight 3.4.0. 

The latest firmware for the VSI010 module remains: 

 642-002-000-009.xmsifw. 

The latest firmware for the VSN010 device remains: 

 642-004-000-011.redboxfw. 

Therefore, for current versions of VibroSmart VSI010 and VSN010 devices, firmware upgrades are not 

required. 

The latest firmware for the VSV30x module is now: 

 642-001-000-015.xtranfw. 

Improvements to this latest VibroSmart VSV30x firmware include support for hydro-air-gap monitoring 

(see 2.11 VSV30x modules: Support for hydro air-gap monitoring). 

NOTE: In order to run VibroSight 3.4.0 for machinery monitoring systems containing 

VibroSmart VSV30x modules, a firmware upgrade to the latest version of VSV30x 

firmware is required. 
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6 Upgrade procedure 

This section describes the procedure for upgrading a VibroSight system from a previous version. 

Perform the steps in the given sequence in order to complete a system upgrade. 

NOTE: It is strongly recommended to verify the version of firmware running in the related 

hardware (XMx16 cards and VibroSmart modules and devices) before starting a 

VibroSight system upgrade, in order to establish if any firmware updates are also 

required. 

See 6.2.3 Updating the firmware using VibroSight System Manager. 

 

NOTE: It is strongly recommended to ensure that a copy of the configuration for a 

VibroSmart is available before updating the firmware of any of the VibroSmart 

modules used in the distributed monitoring system. See 6.2.3 Updating the 

firmware using VibroSight System Manager. 

 

6.1 VibroSight software user settings 

The VibroSight Software generates and uses some files on the storage device of the computer 

running VibroSight to keep track of user-configurable settings, so that these settings are remembered 

and applied for the VibroSight installation. 

These settings files have an .xmssettings file name extension and on a computer running 

Windows 7, can be found here: 

C:\Users\username\AppData\Roaming\Meggitt\VibroSight, where username is the Windows 

account name. 

For example, the VibroSightVision.xmssettings file records the user-configurable default 

settings for VibroSight Vision, such as default settings for plots. 

NOTE: VibroSight software updates and upgrades do not replace these settings files, so: 

• For a computer on which VibroSight was previously installed, an update, upgrade 

or a re-installation of VibroSight will continue to use the previous defaults recorded 

in the .xmssettings files. 

• For a computer on which VibroSight was not previously installed, the installation 

of VibroSight will generate and use new .xmssettings files, which use the latest 

VibroSight software defaults. 

If a settings file is deleted for any reason, VibroSight will generate and use a new 

settings file, which uses the latest VibroSight software defaults. 
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6.2 Updating VibroSight-compatible hardware 

Appropriate files and tools are included in the installation package to allow VM600 cards (XMx16) and 

VibroSmart devices (VSI010, VSN010 and VSV30x) to be updated to the latest firmware, in order to 

take advantage of improvements to the VibroSight software. 

Updating the firmware VM600 cards or VibroSmart devices is a special task that can, if used 

unintentionally or incorrectly, lead to malfunctioning of the device and affect proper function of data 

acquisition. 

During the firmware update of a device, the card or module being updated cannot provide its normal 

machinery monitoring functions because its outputs (alarms and relays) can go to undetermined 

states, irrespective of how they have been configured. 

For VibroSmart modules, the machinery being monitored is not protected for the duration of a firmware 

update and the restart (reboot) that is triggered automatically after the firmware update (which can 

take up to 5 minutes). 

NOTE: It is highly recommended that firmware updates are only performed in accordance 

with the operating procedures for the machinery being monitored and that 

appropriate precautions are taken at the control system level (such as DCS 

or PLC). 

For example, alarms and relay outputs should be ignored (bypassed or inhibited) in 

order to avoid false trips of the machinery being monitored. 

 

6.2.1 VM600 card firmware 

The latest VM600 card firmware files are copied to a directory on your computer as part of the 

VibroSight software installation process. 

NOTE: For example, the default firmware directory for VM600 cards is: 

C:\Program Files\Meggitt\VibroSight\Firmware\VM600 

 

The firmware files for a VM600 card can be found in the appropriate subfolder and identified by their 

.tgz file name extension. For example, the XMV16 subfolder contains the applications and base 

system firmware for use by XMV16 cards. Any additional firmware updates received from Meggitt 

Sensing Systems should also be stored in these directories. 

Table 1 shows the compatibility between VibroSight software and VM600 CPUR card hardware (that 

is, CPUR firmware). 

Table 2 shows the compatibility between VibroSight software and VM600 XMx16 card hardware (that 

is, XMC16, XMV16 and XMVS16 firmware). 

NOTE: It is strongly recommended to use the most recent version of the VM600 CPUR 

firmware and VM600 XMx16 firmware that is compatible with the version of 

VibroSight software being used. 
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Table 1: VibroSight software and VM600 CPUR firmware compatibility 

 VM600 CPUR firmware. See note 1 

VibroSight software 

version 

CD part number 

Base-system (*.tgz) 

640-014-001-001 640-014-001-002 

Applications (*.tgz) 

640-015-001-001 640-015-001-002 

2.12.7 

609-004-000-036 
 

See note 2
  

See note 3
 

3.0.0 

609-004-000-037 
  

3.1.0 

609-004-000-038 
  

3.2.0 

609-004-000-039 
  

3.3.0 

609-004-000-040 
  

3.4.0 

609-004-000-041 
  

 

Notes for Table 1 

1. VM600 CPUR firmware is packaged and distributed as a .tgz file (a compressed archive file format) with PNRs such as 640-

014-001-xxx for the Base System and 640-015-001-xxx for the (Applications) Firmware. In these PNRs, the xxx-xxx-001-xxx 

denotes the firmware is packaged in the tgz file format. 

After the .tgz file is unpacked by VibroSight System Manager and the firmware is uploaded to a VM600 CPUR card, the dialog 

box displayed by the VibroSight System Manager’s Change Firmware command shows the current version of firmware using 

PNRs such as 640-014-000-xxx for the Base System and 640-015-000-xxx for the Firmware, which correspond to the actual 

unpacked firmware that is running on the card. 

 

2. This is the first official release of VM600 CPUR firmware and includes features such as the management of XMx16 card 

configurations for applications such as control systems and the implementation of the PROFIBUS protocol for the fieldbus 

interfaces. A firmware upgrade is required in order to run VibroSight 2.12.7 or later. 

 

3. This version of VM600 CPUR firmware includes a fix for a known time counter wraparound (overflow) issue. A firmware 

upgrade is strongly recommended in order to run VibroSight 3.4.0 or later. 
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Table 2: VibroSight software and VM600 XMx16 firmware compatibility 

 VM600 XMx16 firmware. See note 1 

VibroSight 

software 

version 

CD part number 

Base-system (*.tgz) 

640-003- 

001-011 

640-003- 

001-012 

640-003- 

001-013 

640-003- 

001-014 

640-003- 

001-016 

Applications (*.tgz) 

640-010- 

001-010 

640-010- 

001-011 

640-010- 

001-012 

640-010- 

001-013 

640-010- 

001-014 

640-010- 

001-016 

2.12.0 

609-004-000-027 
 

See note 2
 

     

2.12.1 

609-004-000-028 
  

See note 3
 

    

2.12.2 

609-004-000-029 
  

    

2.12.3 

609-004-000-030 
  

    

2.12.4 

609-004-000-032 
  

    

2.12.5 

609-004-000-033 
   

See note 4
 

   

2.12.6 

609-004-000-034 
   

   

2.12.7 

609-004-000-036 
    

See note 5
  

 

3.0.0 

609-004-000-037 
     

See note 6
  

3.1.0 

609-004-000-038 
      

3.2.0 

609-004-000-039 
      

3.3.0 

609-004-000-040 
      

See note 7
 

3.4.0 

609-004-000-041 
      

 

Notes for Table 2 (see the next page)  
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Notes for Table 2 

1. VM600 XMx16 firmware is packaged and distributed as a .tgz file (a compressed archive file format) with PNRs such as 640-

003-001-xxx for the Base System and 640-010-001-xxx for the (Applications) Firmware. In these PNRs, the xxx-xxx-001-xxx 

denotes the firmware is packaged in the tgz file format. 

After the .tgz file is unpacked by VibroSight System Manager and the firmware is uploaded to a VM600 XMx16 card, the dialog 

box displayed by the VibroSight System Manager’s Change Firmware command shows the current version of firmware using 

PNRs such as 640-010-000-xxx for the Firmware and 640-003-000-xxx for the Base System, which correspond to the actual 

unpacked firmware that is running on the card. 

 

2. This version of VM600 XMx16 firmware introduces support for hydro air-gap monitoring. 

 

3. This version of VM600 XMx16 firmware introduces support for 1 s time-boxed peak-hold processing (that is, spectral data 

aggregation). 

 

4. This version of VM600 XMx16 firmware implements improved multi-rate digital resamplers (sample rate converters). 

A firmware upgrade is recommended but not required in order to run VibroSight 2.12.5 or 2.12.6. 

 

5. This version of VM600 XMx16 firmware improves support for faster live data: 100 ms card update rate and up to 100 ms 

VibroSight Vision refresh rate. It also allows a VM600 XMx16 card to be managed by a VM600 CPUR card (“rack controller”), 

eliminating the XMx16 card’s requirement for a VibroSight Server. A firmware upgrade is required in order to run 

VibroSight 2.12.7. 

 

6. This version of VM600 XMx16 firmware adds support for customer-specific functionality that is enabled by a customer-specific 

VibroSight software licence. A firmware upgrade is required in order to run VibroSight 3.0.0 or later. 

 

7. This version of VM600 XMx16 firmware includes relaxed constraints for dynamic data retention time, that is, optimised 

memory to reduce the possibility of missing data in data intensive VibroSight applications running on less powerful computers. A 

firmware upgrade is required in order to run VibroSight 3.3.0 or later. 
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6.2.2 VibroSmart device firmware 

The latest VibroSmart device firmware files are copied to a directory on your computer as part of the 

VibroSight software installation process. 

NOTE: The default firmware directory for VibroSmart devices is: 

C:\Program Files\Meggitt\VibroSight\Firmware\VibroSmart 

 

The firmware files for a VibroSmart device can be found in the appropriate subfolder and identified by 

their .*fw file name extension. For example, the VSV30x subfolder contains the firmware for use by 

VSV30x modules. Any additional firmware updates received from Meggitt Sensing Systems should 

also be stored in these directories. 

Table 3 shows the compatibility between VibroSight software and the VibroSmart VSI010 firmware. 

Table 4 shows the compatibility between VibroSight software and the VibroSmart VSN010 firmware. 

Table 5 shows the compatibility between VibroSight software and the VibroSmart VSV30x firmware. 

 

NOTE: It is strongly recommended to use the most recent version of the VibroSmart 

firmware that is compatible with the version of VibroSight software being used. 
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Table 3: VibroSight software and VibroSmart VSI010 firmware compatibility 

 VSI010 firmware (*.xmsifw). See note 1 

VibroSight 

software version 

CD part number 

642-002 

-000-006 

642-002- 

000-007 

642-002- 

000-008 

642-002- 

000-009 

2.12.0 

609-004-000-027 


 See note 2
 

   

2.12.1 

609-004-000-028 
 

 See note 2
 

  

2.12.2 

609-004-000-029 
  

  

2.12.3 

609-004-000-030 
  

 See note 2
 

 

2.12.4 

609-004-000-032 
   

 

2.12.5 

609-004-000-033 
   

 

2.12.6 

609-004-000-034 
   

 See note 2
 

2.12.7 

609-004-000-036 
    

3.0.0 

609-004-000-037 
    

3.1.0 

609-004-000-038 
    

3.2.0 

609-004-000-039 
    

3.3.0 

609-004-000-040 
    

3.4.0 

609-004-000-041 
    

 

Notes for Table 3 

1. VibroSmart VSI010 firmware is distributed as a single .xmsifw file (a proprietary file format) with a PNR such as 642-xxx-000-

xxx. In these PNRs, the xxx-xxx-000-xxx denotes that the firmware is not packaged (compressed or archived). VibroSight 

System Manager always uses and displays information about VibroSmart device firmware using PNRs such as 642-xxx-000-

xxx, which correspond to the actual firmware that is running on the device. 
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2. Updating to this version of VibroSmart VSI010 firmware requires a specific process: 

Notes: 

For a VibroSmart consisting of different types of device, the devices should be updated in the following order: first VSN010 real-

time Ethernet switches, then VSV30x vibration monitoring modules and finally VSI010 communications interface modules. In 

addition, VibroSight System Manager should be exited (closed) and restarted after updating the firmware for each type of 

device, before continuing. And after updating the firmware, the configuration on the VibroSmart devices should be re-applied 

(re-activated) and the VibroSmart devices should be restarted. 

Procedure: 

(1) Ensure that a copy of the configuration for the VibroSmart is available before updating any device firmware. For example, 

using the currently installed version of VibroSight (that is, before any updates to the VibroSight software corresponding to 

updates to VibroSmart devices), VibroSight Configurator can be used to obtain a copy of the configuration as follows: 

• For a VibroSmart using a VibroSight Server, the File > Open > Server / Database command can be used to read the 

configuration from the VibroSight Server. 

• For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” VibroSmart), the File > Open > Device command can 

be used to read the configuration directly from the VibroSmart modules. 

Then the File > Save As > File command can be used to store a copy of the configuration for the VibroSmart. 

 (2) Start VibroSight System Manager, select the device or devices of the same type to be updated (for example, VSI010 

modules) and run the Change Firmware command. 

When updating multiple VibroSmart devices of the same type to use the same firmware, CTRL+click or SHIFT+click can be 

used to select multiple devices in the Devices tree structure of the System Explorer window. This way, when the Change 

Firmware command is run, all of devices that were selected will be updated at the same time. Otherwise, each device must be 

selected and updated individually. 

(3) When the VibroSmart Module(s) Firmware Upgrade window displays a “Firmware upgrade terminated. The firmware has 

been upgraded successfully …” message, click the Finish button to continue. 

If after 10 minutes, the VibroSmart Module(s) Firmware Upgrade window does not display a successful message, click the 

Cancel button to close the window and continue. 

Then exit (close) VibroSight System Manager. 

(4) Restart VibroSight System Manager and verify that the correct version of firmware is reported for each device that was 

updated. (When a device is selected in the System Explorer window, this information is available in the main window (centre) 

under Module PNR. It is also available in the VibroSmart Module(s) Firmware Upgrade window when a device is selected and 

the Change Firmware command is run). 

If a device does not report the correct version of firmware, rerun the Change Firmware command for this device. 

Then exit (close) VibroSight System Manager. 

(5) Repeat steps (2), (3) and (4) for each type of device to be updated (for example, VSN010 and VSV30x modules). 

(6) Start VibroSight Configurator, open the configuration for the VibroSmart (see step (1)), then apply (activate) the 

configuration. (If required, VibroSight Configurator will automatically update the configuration to the latest version and inform the 

user.) 

Then exit (close) VibroSight Configurator. 

(7) Turn the power supply to the VibroSmart off and wait for a few seconds. Then turn the power supply back on and verify that 

the system operates as expected. 

During this firmware update process, the behaviour of the LEDs on the front panel of the VibroSmart devices can be 

inconsistent and should be ignored. Normal LED behaviour resumes after the firmware update is complete (after step (7)). 
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Table 4: VibroSight software and VibroSmart VSN010 firmware compatibility 

 VSN010 firmware (*.redboxfw). See note 1 

VibroSight 

software 

version 

CD part number 

642-004- 

000-008 

642-004- 

000-009 

642-004- 

000-010 

642-004- 

000-011 

2.12.0 

609-004-000-027 


 See note 2
 

   

2.12.1 

609-004-000-028 
 

 See note 2
 

  

2.12.2 

609-004-000-029 
  

  

2.12.3 

609-004-000-030 
  

 See note 2
 

 

2.12.4 

609-004-000-032 
   

 

2.12.5 

609-004-000-033 
   

 

2.12.6 

609-004-000-034 
   

 See note 2
 

2.12.7 

609-004-000-036 
    

3.0.0 

609-004-000-037 
    

3.1.0 

609-004-000-038 
    

3.2.0 

609-004-000-039 
    

3.3.0 

609-004-000-040 
    

3.4.0 

609-004-000-041 
    

 

Notes for Table 4 

1. VibroSmart VSN010 firmware is distributed as a single .redboxfw file (a proprietary file format) with a PNR such as 642-xxx-

000-xxx. In these PNRs, the xxx-xxx-000-xxx denotes that the firmware is not packaged (compressed or archived). VibroSight 

System Manager always uses and displays information about VibroSmart device firmware using PNRs such as 642-xxx-000-

xxx, which correspond to the actual firmware that is running on the device. 
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2. Updating to this version of VibroSmart VSN010 firmware requires a specific process: 

Notes: 

For a VibroSmart consisting of different types of device, the devices should be updated in the following order: first VSN010 real-

time Ethernet switches, then VSV30x vibration monitoring modules and finally VSI010 communications interface modules. In 

addition, VibroSight System Manager should be exited (closed) and restarted after updating the firmware for each type of 

device, before continuing. And after updating the firmware, the configuration on the VibroSmart devices should be re-applied 

(re-activated) and the VibroSmart devices should be restarted. 

Procedure: 

(1) Ensure that a copy of the configuration for the VibroSmart is available before updating any device firmware. For example, 

using the currently installed version of VibroSight (that is, before any updates to the VibroSight software corresponding to 

updates to VibroSmart devices), VibroSight Configurator can be used to obtain a copy of the configuration as follows: 

• For a VibroSmart using a VibroSight Server, the File > Open > Server / Database command can be used to read the 

configuration from the VibroSight Server. 

• For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” VibroSmart), the File > Open > Device command can 

be used to read the configuration directly from the VibroSmart modules. 

Then the File > Save As > File command can be used to store a copy of the configuration for the VibroSmart. 

 (2) Start VibroSight System Manager, select the device or devices of the same type to be updated (for example, VSN010 

modules) and run the Change Firmware command. 

When updating multiple VibroSmart devices of the same type to use the same firmware, CTRL+click or SHIFT+click can be 

used to select multiple devices in the Devices tree structure of the System Explorer window. This way, when the Change 

Firmware command is run, all of devices that were selected will be updated at the same time. Otherwise, each device must be 

selected and updated individually. 

(3) When the VibroSmart Module(s) Firmware Upgrade window displays a “Firmware upgrade terminated. The firmware has 

been upgraded successfully …” message, click the Finish button to continue. 

If after 10 minutes, the VibroSmart Module(s) Firmware Upgrade window does not display a successful message, click the 

Cancel button to close the window and continue. 

Then exit (close) VibroSight System Manager. 

(4) Restart VibroSight System Manager and verify that the correct version of firmware is reported for each device that was 

updated. (When a device is selected in the System Explorer window, this information is available in the main window (centre) 

under Module PNR. It is also available in the VibroSmart Module(s) Firmware Upgrade window when a device is selected and 

the Change Firmware command is run). 

If a device does not report the correct version of firmware, rerun the Change Firmware command for this device. 

Then exit (close) VibroSight System Manager. 

(5) Repeat steps (2), (3) and (4) for each type of device to be updated (for example, VSI010 and VSV30x modules). 

(6) Start VibroSight Configurator, open the configuration for the VibroSmart (see step (1)), then apply (activate) the 

configuration. (If required, VibroSight Configurator will automatically update the configuration to the latest version and inform the 

user.) 

Then exit (close) VibroSight Configurator. 

(7) Turn the power supply to the VibroSmart off and wait for a few seconds. Then turn the power supply back on and verify that 

the system operates as expected. 

During this firmware update process, the behaviour of the LEDs on the front panel of the VibroSmart devices can be 

inconsistent and should be ignored. Normal LED behaviour resumes after the firmware update is complete (after step (7)). 
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Table 5: VibroSight software and VibroSmart VSV30x firmware compatibility 

 VSV30x firmware (*.xtranfw). See note 1 

VibroSight 

software 

version 

CD part number 

642-001-000-

010 

642-001-

000-011 

642-001-

000-012 

642-001-

000-013 

642-001-

000-014 

642-001-

000-015 

2.12.0 

609-004-000-027 


 See note 2
 

     

2.12.1 

609-004-000-028 
 

 See note 2
 

    

2.12.2 

609-004-000-029 
  

    

2.12.3 

609-004-000-030 
  

 See note 2
 

   

2.12.4 

609-004-000-032 
   

   

2.12.5 

609-004-000-033 
   

 See note 2
 

  

2.12.6 

609-004-000-034 
    

 See note 2
 

 

2.12.7 

609-004-000-036 
     

 

3.0.0 

609-004-000-037 
     

 

3.1.0 

609-004-000-038 
     

 

3.2.0 

609-004-000-039 
     

 

3.3.0 

609-004-000-040 
     

 

3.4.0 

609-004-000-041 
     


See notes 

2 and 3
 

 

Notes for Table 5 

1. VibroSmart VSV30x firmware is distributed as a single .xtranfw file (a proprietary file format) with a PNR such as 642-xxx-

000-xxx. In these PNRs, the xxx-xxx-000-xxx denotes that the firmware is not packaged (compressed or archived). VibroSight 

System Manager always uses and displays information about VibroSmart device firmware using PNRs such as 642-xxx-000-

xxx, which correspond to the actual firmware that is running on the device. 
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2. Updating to this version of VibroSmart VSV30x firmware requires a specific process: 

Notes: 

For a VibroSmart consisting of different types of device, the devices should be updated in the following order: first VSN010 real-

time Ethernet switches, then VSV30x vibration monitoring modules and finally VSI010 communications interface modules. In 

addition, VibroSight System Manager should be exited (closed) and restarted after updating the firmware for each type of 

device, before continuing. And after updating the firmware, the configuration on the VibroSmart devices should be re-applied 

(re-activated) and the VibroSmart devices should be restarted. 

Procedure: 

(1) Ensure that a copy of the configuration for the VibroSmart is available before updating any device firmware. For example, 

using the currently installed version of VibroSight (that is, before any updates to the VibroSight software corresponding to 

updates to VibroSmart devices), VibroSight Configurator can be used to obtain a copy of the configuration as follows: 

• For a VibroSmart using a VibroSight Server, the File > Open > Server / Database command can be used to read the 

configuration from the VibroSight Server. 

• For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” VibroSmart), the File > Open > Device command can 

be used to read the configuration directly from the VibroSmart modules. 

Then the File > Save As > File command can be used to store a copy of the configuration for the VibroSmart. 

 (2) Start VibroSight System Manager, select the device or devices of the same type to be updated (for example, VSV30x 

modules) and run the Change Firmware command. 

When updating multiple VibroSmart devices of the same type to use the same firmware, CTRL+click or SHIFT+click can be 

used to select multiple devices in the Devices tree structure of the System Explorer window. This way, when the Change 

Firmware command is run, all of devices that were selected will be updated at the same time. Otherwise, each device must be 

selected and updated individually. 

(3) When the VibroSmart Module(s) Firmware Upgrade window displays a “Firmware upgrade terminated. The firmware has 

been upgraded successfully …” message, click the Finish button to continue. 

If after 10 minutes, the VibroSmart Module(s) Firmware Upgrade window does not display a successful message, click the 

Cancel button to close the window and continue. 

Then exit (close) VibroSight System Manager. 

(4) Restart VibroSight System Manager and verify that the correct version of firmware is reported for each device that was 

updated. (When a device is selected in the System Explorer window, this information is available in the main window (centre) 

under Module PNR. It is also available in the VibroSmart Module(s) Firmware Upgrade window when a device is selected and 

the Change Firmware command is run). 

If a device does not report the correct version of firmware, rerun the Change Firmware command for this device. 

Then exit (close) VibroSight System Manager. 

(5) Repeat steps (2), (3) and (4) for each type of device to be updated (for example, VSI010 and VSN010 modules). 

(6) Start VibroSight Configurator, open the configuration for the VibroSmart (see step (1)), then apply (activate) the 

configuration. (If required, VibroSight Configurator will automatically update the configuration to the latest version and inform the 

user.) 

Then exit (close) VibroSight Configurator. 

(7) Turn the power supply to the VibroSmart off and wait for a few seconds. Then turn the power supply back on and verify that 

the system operates as expected. 

During this firmware update process, the behaviour of the LEDs on the front panel of the VibroSmart devices can be 

inconsistent and should be ignored. Normal LED behaviour resumes after the firmware update is complete (after step (7)). 

 

3. This version of VibroSmart VSV30x firmware introduces support for hydro air-gap monitoring. 

A firmware upgrade is required in order to run VibroSight 3.4.0. 
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6.2.3 Updating the firmware using VibroSight System Manager 

When performing VibroSight software upgrades, it is strongly recommended to systematically upgrade 

the firmware of VM600 XMx16 cards and VibroSmart devices to the latest compatible version. 

Failure to perform a necessary VibroSight-compatible VM600 card firmware update may lead to 

incoherent system behaviour and affect the proper functioning of data acquisition in a system. It is only 

in systems where the firmware running on the XMx16 cards and VibroSmart devices already 

corresponds to the latest available version that no firmware update is required. Therefore, it is strongly 

recommended to verify the version of firmware running on the hardware before starting a VibroSight 

system upgrade, in order to establish if a firmware update is also required. 

NOTE: Changing the firmware of the VibroSight hardware is a special administrative task 

that can – if performed unintentionally – affect the proper functioning of data 

acquisition in a system. 

It is therefore strongly recommended to change the firmware of the VibroSight 

hardware only when it is necessary. For example, when the devices must be 

updated to be compatible with a VibroSight software upgrade. 

 

For VibroSmart modules, each module can be selected and its firmware updated individually. 

Alternatively, multiple modules of the same type (for example, VSV3x0) can be updated to the same 

version of firmware at the same time. 

NOTE: It is strongly recommended to ensure that a copy of the configuration for a 

VibroSmart is available before updating the firmware of any of the VibroSmart 

modules used in the distributed monitoring system. 

For example, using the currently installed version of VibroSight (that is, before any 

updates to the VibroSight software corresponding to updates to VibroSmart 

modules), VibroSight Configurator should be used to obtain a copy of the 

configuration as follows:  

For a VibroSmart using a VibroSight Server, the File > Open > Server / Database 

command can be used to read the configuration from the VibroSight Server. 

For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” 

VibroSmart), the File > Open > Device command can be used to read the 

configuration directly from the VibroSmart modules. 

Then the File > Save As > File command should be used to store a copy of the 

configuration for the VibroSmart distributed monitoring system. 

 

Update the firmware on a VibroSight device using the  Change Firmware tool (from VibroSight 

System Manager’s Maintenance tools): 

1. Ensure that the computer running the VibroSight software is on the same network as the 

hardware (XMx16 card or VibroSmart module or device) to be updated. 

2. Start VibroSight System Manager and navigate to the Devices tree structure in the System 

Explorer window. 
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The Devices tree lists all of the VibroSight compatible hardware that VibroSight can see on the 

network. If there are no XMx16 cards or VibroSmart devices in the tree structure or some cards 

are missing, verify your network connections. 

3. Select the card or device that requires its firmware to be changed. 

The Actions tool window updates to show the available tools. 

To change multiple VibroSmart to use the same version of firmware at the same time, use 

CTRL+click or SHIFT+click to select multiple devices from the Devices tree-view. (Then, when 

the Change Firmware command is run, all of the devices that were selected will be updated at 

the same time.) 

4. Click  Change Firmware in the Maintenance tools group of the Actions window. 

The Change Firmware dialog box appears. 

5. Click the Add button and select the new firmware files for the card or new firmware file for the 

device. 

 NOTE: The Change Firmware dialog box automatically opens the firmware folder 

corresponding to the VibroSight-compatible VM600 card or VibroSmart device 

selected. 

.tgz files are for VM600 cards and .*fw files are for VibroSmart devices. 

 

6. Click the Finish button to start the firmware upgrade process. 

For XMx16 cards and VibroSmart devices, the firmware upgrade process can take up to 

5 minutes, during which: 

 The IP address beside the device’s serial number in the Devices tree structure can 

disappear. 

 The LEDs on the front panel of the device can change to reflect the status of the upgrade. 

7. Repeat steps 3 to 6 for each device that requires a firmware update. 

 NOTE: Although the firmware for each VibroSight device must be changed individually 

using the  Change Firmware tool, as each device updates its firmware 

independently of the VibroSight software (once the process has started), firmware 

updates can be performed on several devices in parallel. 

 

8. After the firmware upgrade, verify that the VibroSight system is acquiring data from the cards. 

 NOTE: Refer also to the Changing the firmware topics in the  VibroSight help. 

 

The  Change Firmware tool can be used to load a VibroSight device with any version of 

firmware. It is therefore possible to change a device’s firmware to any previously available version, as 

well as the latest update. 
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This feature can be useful in certain situations, for example, swapping spare VibroSight hardware 

between different VM600 racks or VibroSmart distributed monitoring systems, where systems are 

operating with different versions of VibroSight. 

 

6.3 Final checks 

After upgrading the VibroSight software, the following checks are recommended to ensure that 

VibroSight has not been inadvertently modified and that it continues to operate as expected: 

 Use VibroSight Configurator to run a consistency check on the configuration in order to ensure 

that the configuration has not been modified by any changes to the VibroSight software, 

internal database structure and firmware for the hardware (VM600 cards and VibroSmart 

modules). 

 Use the VibroSight Server window to check that the data acquisition, data post-processing and 

data logging settings are as expected. 

In VibroSight Server, under Device drivers, use the appropriate controls to enable 

communications with the VibroSight-compatible hardware, and under Server features, use 

the appropriate controls to enable the required post processing, for example, data logging. 
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7 Customer support 

7.1 Contacting us 

Meggitt Sensing Systems worldwide customer support network offers a range of support including 

Technical support and Sales and repairs support. For customer support, please contact your local 

Meggitt Sensing Systems representative. Alternatively, contact our main office: 

Customer support 

Meggitt SA 

Route de Moncor 4 

PO Box 1616 

1701 Fribourg 

Switzerland 

 

Telephone: +41 (0) 26 407 11 11 

Email: energysupport@ch.meggitt.com 

Web: www.meggittsensing.com/energy 

 

7.2 Technical support 

Meggitt Sensing Systems technical support team provide both pre-sales and post-sales technical 

support, including: 

 General advice 

 Technical advice 

 Troubleshooting 

 Site visits. 

 

7.3 Sales and repairs support 

Meggitt Sensing Systems sales team provide both pre-sales and post-sales support, including advice 

on: 

 New products 

 Spare parts 

 Repairs. 

 

mailto:energysupport@ch.meggitt.com
http://www.meggittsensingsystems.com/
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VibroSight software and Windows operating system compatibility 

 

 

Windows 7 Windows 8.1 Windows 10 

VibroSight software compatible? 

Yes 

(but not recommended for new 

installations as Microsoft support for 

Windows 7 ends in January 2020).  

Yes Yes 

 

 

VibroSight software and Windows Server operating system compatibility 

 

 

Windows Server 2008 R2 Windows Server 2012 Windows Server 2016 

VibroSight software compatible? 

Yes 

(but not recommended for new 

installations as Microsoft support for 

Windows Server 2008 R2 ends in 

January 2020) 

Yes Yes 
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VibroSight software and Microsoft .NET Framework requirements 

VibroSight software version Microsoft .NET Framework requirements 

VibroSight 3.4.0 or later .NET Framework 4.7.1 
See note 1

 

VibroSight 3.0.0 or later .NET Framework 4.6 

VibroSight 2.12.0 or later .NET Framework 4.5 and .NET Framework 2.0 
See note 2

 

VibroSight 2.9.4 or later .NET Framework 4.5 

VibroSight 2.9.3 and 2.9.2 .NET Framework 4 (Standalone Installer) 

VibroSight 2.9.1 or earlier .NET Framework 3.5 SP1 
 

Notes 

1. Microsoft .NET Framework 4.7.1 replaces .NET Framework versions 4.0 to 4.7. 

2. Since Microsoft .NET Framework 3.5 also includes .NET Framework 2.0 and .NET Framework 3.0, installing Microsoft .NET Framework 3.5 SP1 is the recommended solution for most computers 

(rather than installing Microsoft .NET Framework 2.0). 
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